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What's New in QuarkXPress 2017

This document provides an introduction to new features and enhancements in

QuarkXPress 2017, including:

• Digital publishing

• "Unlimited" iOS single apps

• Adaptive layout conversions

• Automatic table-of-contents

• New and enhanced output styles for HTML5 Publications, App Studio and

iOS apps

• Enhanced HTML5 and 360 degree interactivity

• Images and Vectors

• Non-destructive image editing (adjustments and filters)

• Transparency blend modes

• New shape tools

• More multi-color gradients

• Gradients for frames

• Item format painter

• Typography and Text

• Text stroking

• Text and paragraph shading

• Column flow

• Non-breaking text attribute

• Automatic lines between columns

• Merging text boxes

• Proportional leading

• Enhanced smart quotes and the addition of smart dashes

• Enhanced link/unlink tool

WHAT'S NEW IN QUARKXPRESS 2017 | 3

WHAT'S NEW IN QUARKXPRESS 2017



• Enhanced Word import including Word table importing

• General

• Adaptive layout conversions

• Enhanced convert to native objects

• Mac and Windows UI enhancements

• Enhanced cursor key movement

• Recently used font lists

• Find/Change enhancements

• Enhanced cross references

• Built-in cache cleaner

• Enhanced XTensions manager

• Save a Copy As / Downsaving

Please refer to A Guide to QuarkXPress 2017 for details or visit

www.quark.com/support/documentation
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Digital Publishing

The following changes have been made, enhancing the digital publishing features of

QuarkXPress:

Direct iOS App Export
With QuarkXPress 2017 it is now possible to export content directly as a single iOS

app, without having Xcode installed on your Mac. All you need to use this free cloud

service from QuarkXPress 2017 is an internet connection. QuarkXPress 2017 makes

the process simple with the new Export as iOS App feature.

You will need an Apple Developer Account, which will add additional costs, to create

the required Apple certificates and provisioning profiles to build the iOS App.

For Windows users: You can do almost everything on the Windows platform too; but

when uploading the final app to Apple’s App Store, Apple requires you to use a Mac.

There are third party rental services available to rent a Mac for a limited time to upload

the final app to Apple.

Multi-variant HTML5 Publications, and App Studio Apps, Direct iOS Apps
QuarkXPress 2017 allows you to export multiple digital layouts, of various device sizes,

as a single HTML5 package. (For example you can create layouts for iPad (Vertical

and/or Horizontal), then duplicate it using adaptive settings to iPhone (V and/or H)

etc). QuarkXPress 2017 also allows you to export multiple digital layouts as an App

Studio Apps or a direct iOS App. The App will load the appropriate layout based on

the size of the user's device.

Once exported you can publish them all as “HTML5 Publication” to get a folder that

contains HTML for all the selected layouts. When published to a web server, the web

reader will be responsive and automatically serve the correct HTML based on the device

size used to access the website.

When exporting as HTML5 Publication, you can select one or more digital layouts,

from those available in a project, to create HTML.
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You will also see the option to select multiple layouts while uploading to App Studio

and exporting as iOS App.

Named Sections in Page Layout Palette
Using the new Section dialog you can specify a unique name for each section.

The name has to be set on the first page of the corresponding section. This name will

be used to specify pages to create rich TOC for HTML5 output (i.e. HTML5 Publications,

App Studio and iOS App export). You may leave it blank if you don't intend to use it.

Rich TOC Support in HTML5 Publications, App Studio Apps, Direct iOS Apps
HTML5 Publications and App Studio output now support Table of Contents. You can

create rich design TOCs and include it as part of your digital publication. With this
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new capability, you no longer need to jump back to the beginning of the

book/publication to access the TOC. You can open TOC anytime while reading the

digital publication.

Enhanced Output Styles for App Studio
Output Styles for App Studio Publishing has been enhanced for QuarkXPress 2017.

This gives the user a similar experience for App Studio Publishing, HTML5 Publications

and iOS App Export.

New Output Styles for HTML5 Publications and Direct iOS App Export
Output styles have been enhanced to support HTML5 Publication output settings. You

can also configure the Web Reader app through these settings in addition to the HTML5

export settings.

Native HTML enhancements
Text content, inside non-rectangular text boxes, is now exported as native HTML,

instead of being converted to images.

You may now apply non-solid frames on text boxes without using the "convert to

graphic" option. The content will exported as native HTML.

HTML5 Publications - Reader Enhancements
The new HTML5 Publications reader has been redesigned with several usability

enhancements:

• New unified horizontal toolbar with all (configurable) buttons, and the Scrubber.

• Highly configurable using output styles and export options.

• Pinch zoom, instead of zoom in/out buttons.
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Images and vectors

The following changes have been made, enhancing the images and vectors features

of QuarkXPress:

Non-destructive image editing (adjustments and filters)
The new Image Editing palette allows you edit the raster image of an imported image

in QuarkXPress. You can apply filter effects, color corrections and blend modes to an

image as well as adjust the opacity.

You can apply effects on the image in non-destruction mode and you can also save

images with the effects applied.

You can apply the following filter effects:

• Despeckle - Detects the edges in a picture and blurs all of the picture except those

edges. It removes noise while preserving detail, and can be useful for removing

dust from a scanned image.

• Gaussian Blur - Smooths transitions by averaging pixels next to hard edges of

defined lines and shaded areas in a picture. By checking Blur Picture and/or Blur

Mask, you can apply this filter separately to pictures and their alpha masks..

• Unsharp Mask - Compares pixel values in a defined area to the specified threshold

value. If a pixel has a lower contrast value than the threshold value, its contrast

is increased.

• Find Edges - Outlines the edges of a picture with dark lines against a white

background.
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• Solarize - Blends negative and positive areas of a picture, producing a photographic

solarization effect. To use the Solarize dialog box, enter a Threshold value in the

field or drag the slider. The value specifies which pixels to modify - those with

values lower than the threshold are considered negative and those with values

higher than the threshold are considered positive. The pixel values are then

inverted.

• Diffuse - Shuffles pixels so the picture looks less focused.

• Emboss - Makes areas of the picture appear raised or stamped.

• Embossing Effects - When the Emboss filter is applied, you can specify the direction

from which to raise or stamp the picture using the Embossing Effects filter. Click

the directional arrows in the Embossing Effects dialog box to apply different

directions. For example, clicking the upper-right arrow might specify that when

you pushed a stamp onto an object, you pushed slightly to the right, smearing

the stamp in that direction.

• Edge Detection - Displays only edges of the picture, suppressing the remaining

colors. The Edge Detection dialog box provides two mathematical methods for

determining edges: Sobel and Prewitt. The Sobel method might be more precise

because it considers more surrounding pixels in its calculations.

• Trace Contour - Thinly outlines the transitions of major brightness areas for each

color channel, producing a black-and-white outline of the picture. You have the

option to invert the results as well.

• Add Noise - Applies random pixels to a picture to simulate pictures shot using

high-speed film. The filter applies an even pattern to shadow tones and midtones

while adding a smoother, more saturated pattern to the picture's lighter areas.

• Median - Reduces or eliminates the look of motion on a specified region of a

picture. The effect searches pixels of similar brightness, and replaces the central

pixel with the median brightness value of the searched pixels; pixels that differ

significantly from adjacent pixels remain unaffected.

You can use the following adjustments to apply color corrections to the image:

• Levels - To brighten highlights, compress shadows, and adjust midtones

individually.

• Curves - To make precision tonal adjustments to lighten or darken a picture.

Instead of limiting adjustments to shadows, highlights, and midtones, you can

adjust any point along a scale of 0% to 100% (for CMYK and grayscale) or 0 to

255 (for RGB). The precise nature of this tool requires more experience and

knowledge than using the Levels effect.

• Brightness/Contrast - To adjust the tonality of every pixel instead of individual

channels.

• Color Balance - To remove unwanted color casts or correct over saturated or under

saturated colors. This effect changes the overall mixture of colors in a picture for

generalized color correction.

• Hue/Saturation - To adjust the overall color intensity and light in a washed-out

or muted picture, but is generally used as a special effect. The picture's current
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hue (color cast), saturation (intensity), and lightness (degree of white light) are

expressed as zeros by default.

• Selective Color - To increase or decrease the amount of process color in each of

the primary colors in a picture. For example, if an apple is too purple, you can

take cyan out of the areas that affect red.

• Gamma Correction - To adjust the white point. Adjusting the white point controls

the brightness of the picture's display on screen. To use the Gamma Correction

dialog box, adjust the midtones by entering a new value in the Gamma field or

by dragging the slider. A higher value produces a darker picture, overall.

• Desaturate - To convert a color picture to a black-and-white picture while leaving

the color mode and lightness value of each pixel unchanged. For example, it

assigns equal red, green, and blue values to each pixel in an RGB picture to make

the picture appear grayscale.

• Invert - To invert the gray values of each channel in a picture.

• Threshold - To convert color pictures to black and white, without using gray.

• Posterize - To modify the tonal levels for each channel in a picture to produce

special effects.

As you apply effects to the selected image, you will see the effects immediately in the

layout. You can rearrange the order in which the effects are applied as well as delete

any you do not want. Once you have specified the effects for the selected picture, you

can copy the set of attributes and apply them to other image. You can save the picture

with or without the picture effects applied.
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Transparency blend modes
QuarkXPress introduces support for transparency blend modes. Blending modes let

you vary the ways that the colors of objects blend with the colors of underlying objects.

You can apply blend modes to boxes, frames, images, text and lines:

• Using the Colors palette (Window > Colors).

• Using the Image Editing palette (Window > Image Editing).

• Using the Home, Picture Box, Text and Frame tabs of the Measurements palette

You can apply the following blend effects:

• Normal: This will never change the color values of both top and bottom objects.

This is the default mode

• Multiply: When the Multiply blend mode is applied to the top object, each color

pixel of the top object will be multiplied with each color pixel of the bottom

object.

• Screen: When the Screen blend mode is applied to the top object, the color pixels

of both the top and bottom objects will first be inverted, and then be multiplied,

and then resultant color pixels will be inverted. The resulting color is usually a

lighter color.

• Overlay: This is a combination of the Multiply and Screen blend modes. Lighter

colors become even lighter and dark colors become even darker, depending on

the color of the bottom object in overlapped areas.

• Darken: Lighter pixels in overlapped areas will become darker.

• Lighten: The Lighten blend mode is the opposite of the Darken blend mode;

Darker pixels in overlapped areas will become lighter.

• Color Dodge: The color of the bottom object will become lighter, depending

upon the color of the top object.
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• Color Burn: The color of the bottom object will become darker, depending upon

the color of the top object.

• Hard Light: The Hard Light blend mode is a combination of the Multiply and

Screen blending modes.

• Soft Light: Darkens or lightens the colors, depending on the color of the bottom

objects. The resultant color is brighter if the color of the bottom object is less than

50% of gray values. The resultant color is darker if the color of the bottom object

is more than 50% of gray values.

• Difference: Subtracts the brighter color value of the object with another object

color irrespective of the stack order.

• Exclusion: This is similar to the Difference blend mode with lower contrast.

New shape tools
The following new Shape tools have been added to the QuarkXPress tool palette that

allow you to quickly and easily create different shapes:

• Star tool

• Polygon tool

• Rounded Rectangle tool

• Diamond tool

• Triangle tool

• Wave tool

• Spiral tool

• Cloud tool

You can edit the default shape attributes and save defined shapes to use over and over.
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Enhancements to multi-color gradients
Multi-color gradients have been enhanced to support the following:

• You can now create multi color gradients using Diamond and Rectangular blend

types. Previously only two colors were allowed for these blend types.

• Gradients can be applied to box frames.

• Gradients can be applied to lines.

• Gradients can be added to the list of project colors, allowing you to reuse them.

Item format painter
The new Item Format Painter tool allows you to copy all attributes that have been

applied to an item and apply them to any other item. The Item Format Painter works

across all layouts in the same project, allowing you to copy attributes from one item

to another on the same layout, or to an item on a different layout.

The tool will retain the attributes you have copied until you select another item tool

or a blank space on the canvas, allowing you to select as many boxes as you wish and

apply these attributes over and over.
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Typography and text

The following changes have been made, enhancing the typography and text features

of QuarkXPress:

Text Stroking
QuarkXPress allows you to draw an outline (or stroke) around individual text characters.

You can define the color, width and type of join of your strokes. You can define a text

stroke as part of a character or paragraph style sheet.

Text Shading
QuarkXPress has added a new palette and a new tab to the Measurements palette to

allow you to apply text shading to an entire paragraph or just a selection of text within

a paragraph.

The new Text Shading Styles palette contains controls allowing you to add, edit, and

delete text shading styles
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You can also use the new text shading styles within style sheets (both paragraph and

character).

Column flow
QuarkXPress now offers the ability to set column flow attributes on selected text to

specify how text flows in relation to columns.

You can set the column flow using the Column Flow tab of the Measurements palette,

or on Windows by using the new Column Flow tab of the Paragraph Attributes

dialog (Style > Formats). These tabs contain controls allowing you to set column flow

attributes on the currently selected text.

A column block is any span/split column paragraphs that have similar column flow

attributes applied.

The column flow capabilities include:

• Split Columns: In a single column text flow you can now split selective text into

multiple columns. You can use the Split Columns option to achieve a multi-column

effect on selected paragraphs in a single-column box.

• Span Columns: If you already have a text flow in multiple columns, you can

select a paragraph (or more) to span across multiple columns.

• Line between: If you have two or more split columns, this enables you to add a

line in between them.

• Restart/Continuous Flow Order: Select Continuous (the default flow order) to

leave the selected paragraph in its original column or Restart to move the

paragraph to the start of the column block. The Restart option can be selected

either independently or along with the Span Columns option. When choosing

Restart, the text in the paragraphs before the selected paragraph will be rebalanced

among the columns.

• Spacing between column blocks: If a column block has multiple paragraphs,

then Space Before will be taken from the first paragraphs and similarly Space

After will be taken from the last paragraph of the block.
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If Space Before and/or Space After attributes are specified in both the Paragraph

Attributes and the Column Flow tabs of the Measurements palette, the larger

value will be applied, they will not be added.

Non-breaking text attribute
QuarkXPress lets you apply a non-breaking attribute on selected text and the text will

not hyphenate or wrap. You can also choose to highlight all text that has the

non-breaking attribute applied to it.

Merge text boxes
You can merge selected text boxes and retain the text flow in correct order,
using a new menu option (Item > Merge Text Boxes). You can choose to
merge the boxes in a top down order or in the order in which the boxes were
selected.

Line between columns
QuarkXPress give you the capability to apply a line between two or more columns.

Proportional Leading
QuarkXPress now supports proportional leading to specify the leading value in terms

of percentages (between -100% and 5000%). When you specify the leading in a

percentage, the line spacing value for each line in the paragraph will be calculated as

the sum of the proportional leading percentage of the font size of the tallest character

in each line of the paragraph plus the font size of the tallest character. For example:
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with a 12pt size and 50% leading, if the tallest character of a line is 12pt, then the

leading is going to be 18pt for the same line.

Enhanced smart quotes and the addition of smart dashes
Smart quotes enhancements: You can now specify default single and double quotes

in Preferences. You can also select different language/region specific smart quotes at

the application level. The Word/Text import will automatically honor these smart

quote settings.

Smart Dashes support: The new Smart Dashes preference is introduced to convert

two consecutive hyphens into an Em Dash while typing in a layout. You can turn this

off by going to Preferences -> Input Settings and check the box for Smart Dashes.

The setting is On by default.

Enhanced link/unlink tool
The link/unlink enhancements allows you to link text boxes with two or more stories.

When linking or unlinking boxes, use the Alt/Option modifier key to maintain the

text in their respective boxes. When unlinking boxes use the Shift+Option modifier

to move the box out of the text chain with its text.

Enhanced Word import including Word table importing
QuarkXPress has enhanced the Word import filter to add options to include/exclude

footnotes, tables, style sheets, hyperlinks and inline pictures. You can also choose to

convert quotes when you import a Word document.

Tables are imported as legacy tables, allowing you to edit them in QuarkXPress.

Check Include as Static Footnotes to include any footnotes that the imported Word

document contains as plain text footnotes. If this box is not checked the footnotes

will be imported as dynamic QuarkXPress footnotes.
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General

QuarkXPress 2017 also includes the following new features and enhancements:

Adaptive layout conversion
QuarkXPress has extended the layout automation features by introducing adaptive

settings to allow you to convert layouts to different sizes. This allows you to convert

a print layout to a digital layout with different page sizes. The adaptive settings will

help minimize the manual adjustments needed by automatically resizing the boxes

and adjusting the content with simple design rules. You can also resize print layouts

from one size to another (for example from US letter to A4, or any custom size).

You can apply adaptive scaling in the following ways:

• When duplicating a layout (Layout > Duplicate). This is supported when

duplicating a layout from:

• Print to Print

• Print to Digital

• Digital to Digital

• By using the Layout Properties dialog (Layout > Layout Properties) to resize the

current layout.

This method is currently supported for Print layouts only.

Check Apply Adaptive Scaling and click Options to display the Adaptive Scaling

dialog.

The Scale palette also provides the same configuration as the Adaptive Scaling for

more customizable scaling.
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Enhanced convert to native objects
The Convert to Native Objects feature has been enhanced to allow you to save the

converted images to disk. when converting to native objects or pasting as native objects,

you will see an additional option for Link Raster Images. This will save all raster

images to disk as a raster PDF in same location as your project file. The PDF images

will retain their resolution, color model and color profiles.

Mac and Windows UI enhancements
New theme on Mac OS X: QuarkXPress on Mac introduces new themes called Light

Gray and Gray. These themes give a new modern look with flat icons and buttons all

over the application. By default, the application is set to use the new Gray theme. You

can switch the themes using QuarkXPress preferences.

Windows UI enhancements: QuarkXPress 2017 introduces several UI enhancements,

including:

• HiDPI screens are fully supported.

• Context Menus are optimized, lists have been shortened to allow you to find

relevant options quickly.
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• The ability to drag palettes in and out of a palette group.

Enhanced cursor key movement
Several of QuarkXPress's palettes, including the Measurements palette, have been

enhanced to support cursor key increments/decrements. With this enhancement, you

can easily make minor adjustments for various attributes using the arrow keys on the

keyboard. The modifier keys will additionally support switching higher/lower values.

Font listings
Font listings in QuarkXPress now show the most recently used fonts. The recently

used fonts will appear at the top of the font list and accessible in all dialogs and palettes

where font listing is available. In Preferences, you can specify how many fonts will

be remembered (up to 20).

Find/Change enhancement
Find/Change now allows you to set a preference on how many recent searches to keep.

To disable this feature, please set the value to “0” (zero).

Cross References enhancement
The cross-referencing feature has been enhanced to support text anchors.

Direct access to Quark Cache Cleaner
(Mac OS X only): The Quark Cache Cleaner tool now can be called from QuarkXPress

directly. On Mac OS X the Quark Cache Cleaner option is available under the

QuarkXPress menu. This tool can also be launched from the context menu of the

QuarkXPress 2017 dock icon even when QuarkXPress is not running.

(Windows): You can find Quark Cache Cleaner in the tools folder inside the QuarkXPress

application folder.

Single app bundle on Mac OS X
QuarkXPress on Mac is now a single bundle app. You can simply drag and drop a single

file to the Application folder. In order to make this possible, all the supporting

folders, including the default XTensions, are now internal and have been moved inside

the self-contained app bundle. QuarkXPress 2017 will load third party XTensions from

the following two locations:

• ~/Library/Application Support/Quark/QuarkXPress 2017/XTensions

• /Library/Application Support/Quark/QuarkXPress 2017/XTensions

If the XTension is placed in the main library path, it will be available to all the users

on that Mac. However, if deployed in the user’s library path, the XTension will only

be available to that user. If the same XTension exists in both these locations, then the

one in the user’s library location will be given preference.

The XTensions Disabled folder is deprecated in QuarkXPress 2017 and will not be

supported. The disabled XTensions will be recorded in the following file:
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~/Library/Application Support/Quark/QuarkXPress 2017/

XTSettings.plist

Save a Copy As / Downsaving
Save a Copy As/Downsaving can be called from QuarkXPress directly. This option

is available on the File menu.

OpenType Stylistic Sets Enhancements
QuarkXPress now supports 33 OpenType stylistic sets.
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Legal notices

©2022 Quark Software Inc. and its licensors. All rights reserved.

Protected by the following United States Patents: 5,541,991; 5,907,704; 6,005,560; 

6,052,514; 6,081,262; 6,633,666 B2; 6,947,959 B1; 6,940,518 B2; 7,116,843; 7,463,793; 

and other patents pending.

Quark, the Quark logo, QuarkXPress, and QuarkCopyDesk are trademarks or registered 

trademarks of Quark Software Inc. and its affiliates in the U.S. and/or other countries. 

All other marks are the property of their respective owners.
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